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1. GENERAL INFORMATION

Dear Customer,
thank you for choosing our product. In the following, we will show you
what you should pay attention to during commissioning and use.

Should you encounter any unexpected problems during use, please feel
free to contact us.

With the MotoDriver3 you have the possibility to control and power up to
four DC motors or two stepper motors. The connected motors are
controlled via the PCA9634 chip, which provides an 12C interface.

2. CHANGING THE I12C ADDRESS

This motor driver board can be configured to 128 possible 12C addresses.
These can be chosen freely, but in the further course the default address
0x15is used.

In the following figure you can see which resistors can be changed to
change the 12C address of the motor driver board. You can re-solder these
resistors from Al up to A7 between GND and VDD to get different 12C
addresses.

Here the positions of the seven resistors can be translated to a 7-bit
binary value. Here we take the standard address of the motor driver
board 0x15which can be translated to 001 0101b.
Al=1/A2=0/A3=1]/A4=0/A5=1]/A6=0/A7=0

It should be noted that one should never change the 12C address
during operation as this can lead to unpredictable problems.
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3. PIN ASSIGNMENT

In this section we briefly explain the functions of each pin.
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1. SCL & SDA: 12C interface. Pins for communication with the driver
IC.

2.  nFaultl & nFault2: Status pins of the motor drivers. Outputs a
logical LOW signal if the motor drivers overheat or are loaded with
too much current, for example.

3.  VDD: Voltage output of the voltage converter. This pin outputs
the voltage of the voltage converter integrated on the board. Here
you can choose between 2 voltages via a jumper on the board. 5V
and 3.3V are selectable here.

4. GND: Ground connection.

5. nSLEEP1 & nSLEEP2: Enables the output of the motor drivers.
When these pins are pulled to a logic HIGH signal, the outputs of the
motor drivers are enabled and when the pins are pulled to a logic
LOW signal, the motor drivers go into low-power sleep mode.

6. VM: Output of the motor voltage. This pin outputs the voltage
from DC in, which is used to drive the motors, as a usable voltage.




This motor driver board has 5 screw terminals.

Four of these have the silkscreen "Motor 1.1 | Motor 1.2 | Motor 2.1 and
Motor 2.2". These are the terminals for the motors. Either 2 stepper
motors or 4 DC motors can be connected here. The last terminal is the
voltage input for the motor drivers and the voltage transformer.

It is important that you do not exceed the maximum permissible

voltage of the motor driver board and select the motors accordingly,
otherwise the motor driver board could be damaged.
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Connect the cables of the coils of your stepper motors to the motor
driver board as shown above in order to be able to use them without
any problems.

The "Motor 1.1" terminal will later have pin 0 and pin 1 in the
software.
The "Motor 1.2" terminal will later have pin 2 and pin 3 in the
software.
The "Motor 2.1" terminal will later have pin 4 and pin 5 in the
software.
The "Motor 2.2" terminal will later have pin 6 and pin 7 in the
software.
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4. USE WITH THE RASPBERRY PI

4.1. Connection

[2)

o

>
SBC-MotoDriver3

nFauItz AS INEE
OE 1L ! ! llllllllll
S VDD D

--------

- o m s = m om
UUUUUU

Raspberry Pi SBC-MotoDriver3 External
SDA (Pin 3) SDA -
SCL (Pin 5) SCL -

- nFaultl -
- nFault2 -
GPIO 17 (Pin 11) OE -
- VDD -
GND (Pin 6) GND -
- nSLEEP1 -
- nSLEEP2 -
- VM/DCin External voltage source is

to be aligned according to
the specifications of the
motors

Please note that you cannot connect VDD to your Raspberry Pi
because the voltage converter on the board can only supply 1 amp
and the Raspberry Pi can need more than 1 amp under load. To avoid
damaging the voltage converter ICs and thus the whole board, we
advise you not to connect VDD to your Raspberry Pi.

supply



4.2. Installation
First you need to enable 12C on your Raspberry Pi. To open the
configuration, enter the following command:

sudo raspi-config

There select 3 Interface Options-> P5 /2C.

| Raspberry P1 Software Configuration Teol {raspi-config) |

1 System Optilons Configure system settings
2 Display Options Configure display settings

Interface Options Configure connections to peripherals
4 Performance Options Configure performance settings
5 Localisation Options Configure language and regional settings
6 Advanced Options configure advanced settings
8 Update Update this tool to the latest version
9 About raspi-config Information about this configuration tool

<Select= <Finish>

| Raspberry P1 Software Configuration Tool (raspi-config) |
Pl Camera Enable/disable connection to the Raspberry Pi Camera
P2 SSH Enable/disable remote command line access using SSH
P3 VNC Enable/disable graphical remote access using RealVNC

P4 SPL Enable/disable automatic loading of SPI kernel module
P6 Serial Port Enable/disable shell messages on the serial connection
P7 1-Wire Enable/disable one-wire interface

P8 Remote GPIO Enable/disable remote access to GPIO pins

<Select= <Back=

There you get the question Would you like the ARM 12C Interface to be
enabled?. Confirm this with Ves.

wWould you like the ARM I2C interface to be enabled? The ARM I2C interface is enabled

You have now successfully enabled 12C. The motor driver board is now
accessible under the 12C address 0x15, which is set by default for this
board. The 12C address will be different if you have already configured it
before you configured your Raspberry Pi.

Now to find your motor driver board, you need to download and install
i2c-tools on your Raspberry Pi. You can do this with the following
command.

sudo apt-get install i2c-tools

After downloading and installing i2c-tools, you can now start the
program via

i2cdetect -y 1

To find your motor driver board. If you do this, you should see 0x15 and
0x70 as 12C addresses.

Please note that 0x70 is an internal 12C address of the PCA9634 and
should not be used if it is not necessary. Because this address acts as
hardware reset of the PCA9634.



Next you need to download the required additional libraries, for this you
need to run the following commands.

sudo apt install -y python3-dev python3-pip
pip3 install smbus2
sudo apt install -y git

Next, you need to reboot your Raspberry Pi. To reboot your Raspberry Pi
you just have to execute the following command.

sudo reboot now

For our code example we use the SBC-MotoDriver3-RaspberryPi library
from Joy-IT, which has been released under the GNU-license
and already contains a code example. Use the following command to
download this library from GitHub. Alternatively, you can download just
the code sample here.

git clone https://github.com/joy-it/SBC-MotoDriver3-RaspberryPi.git

Now that you have downloaded the library, you need to run the following
command to use the example from the motor driver board library.

cd SBC-MotoDriver3-RaspberryPi
python3 SBC-MotoDriver3-Example.py

4.3 Use of stepper motors

Please note that only one stepper motor can be connected per side. In
terms of hardware, it is important to use the appropriate stepper motors
for the permissible voltage range. In addition, regardless of the platform
on which you intend to use the product, make sure that you never
connect a stepper motor and a DC motor to the same side at the same
time. This can cause problems or even damage to the product.

In terms of software, make sure that you do not send the stepper motor
function to the same motor driver with the DC motor functions,
regardless of the platform on which you plan to use the product. Always
keep these functions separate from each other.



https://github.com/joy-it/SBC-MotoDriver3-RaspberryPi
https://github.com/joy-it
https://github.com/joy-it/SBC-MotoDriver3-RaspberryPi/blob/main/LICENSE
https://joy-it.net/files/files/Produkte/SBC-MotoDriver3/SBC-MotoDriver3-Testcode-RPi.zip

5. USE WITH THE RASPBERRY PI PICO

5.1. Connection
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Raspberry PiPico = SBC-MotoDriver3 External
Pin0 SDA -
Pin 1 SCL -
- nFaultl -
- nFault2 -

Pin 16 OE -
3V3 VDD -
GND GND -

- nSLEEP1 -
- nSLEEP2 -
- VM/DCin External voltage source is

to be aligned according to
the specifications of the
motors

Please note that when you connect VDD to your Raspberry Pi Pico,
you need to set the output voltage of the voltage converter on the
board to 3.3V with the jumper to be able to power your Pico via the
motor driver board.



5.2. Installation

To use this library on your Raspberry Pi Pico, we recommend that you
download the Thonny Python IDE.

Once you have downloaded the Thonny IDE, you can now download the
latest version of Micropython and flash it to your Pico.

After downloading the latest version of Micropython, you can now flash it
to your Pico by holding down the BOOTSEL button when connecting your
Pico to your PC. Afterwards you can release the BOOTSEL button. The
Pico should now open in Explorer on your monitor. Now simply drag in
the downloaded file and your Pico is flashed with the latest Micropython
version.

5.3. Code example

Next, you can download the library from GitHub. We use the
SBC-MotoDriver3-RaspberryPiPico library from Joy-IT for our code
example, which is released under the GNU-license.

After downloading the *.zip file, you need to unzip it and follow these
steps to use the library without any problems.

1.  Openthe Thonny IDE, go to "View" and activate "Files" there

2.  Create a new folder on your Pico which you name "lib"

3 In the "Files" window that is now open, open the folder in which
the library from GitHub is located

4,  Go to the "lib" folder on your Pico and right click on the
"SBC_MotoDriver3_Lib.py" file in your "Files" window and
download it to your "lib" folder on your Pico

5.  Leave the "lib" folder on your Pico and now download the "SBC-
MotoDriver3-Example.py" file in your "Files" window by right
clicking on your Pico

If you have followed these steps, you can already use the code example.

5.4 Use of stepper motors

Please note that only one stepper motor can be connected per side. In
terms of hardware, it is important to use the appropriate stepper motors
for the permissible voltage range. In addition, regardless of the platform
on which you intend to use the product, make sure that you never
connect a stepper motor and a DC motor to the same side at the same
time. This can cause problems or even damage to the product.

In terms of software, make sure that you do not send the stepper motor
function to the same motor driver with the DC motor functions,
regardless of the platform on which you plan to use the product. Always
keep these functions separate from each other.


https://thonny.org/
https://micropython.org/resources/firmware/rp2-pico-20230426-v1.20.0.uf2
https://github.com/joy-it/SBC-MotoDriver3-RaspberryPiPico
https://github.com/joy-it/PCA9634-Pico/blob/main/LICENSE
https://github.com/joy-it/SBC-MotoDriver3-RaspberryPiPico/blob/main/LICENSE

6. USE WITH ARD-ONE-C (ARDUINO COMPATIBLE)

6.1. Connection
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ARD-ONE-C SBC-MotoDriver3 External
SDA (A4) SDA -
SCL (A5) SCL -

- nFaultl -
- nFault2 -
D4 OE -
VIN VDD -
GND GND -
- nSLEEP1 -
- nSLEEP2 -

- VM/DCin External voltage source is

to be aligned according to
the specifications of the
motors

Please note that if you connect VDD to your ARD-ONE-C, you have to
set the output voltage of the voltage converter on the board with the
jumper to 5V to be able to supply your ARD-ONE-C with voltage via
the motor driver board.




6.2. Installation

For our code example we use the SBC-MotoDriver3-Arduino library from
Joy-IT, which is released under the GNU-license. To use this library, you
need to download it from GitHub. You can install this library by going to
Sketch » Include Library > Add .zip Library.... search for the library you
just downloaded and select it.

6.3.Code example

To test your motor driver board with a code example, simply go to File »
Examples » SBC-MotoDriver3-Arduinoin your Arduino IDE and then to
SBC-MotoDriver3-Example.... Click Upload to upload the code sample
to your Arduino. You can also download the code sample here.

6.4 Use of stepper motors

Please note that only one stepper motor can be connected per side. In
terms of hardware, it is important to use the appropriate stepper motors
for the permissible voltage range. In addition, regardless of the platform
on which you intend to use the product, make sure that you never
connect a stepper motor and a DC motor to the same side at the same
time. This can cause problems or even damage to the product.

In terms of software, make sure that you do not send the stepper motor
function to the same motor driver with the DC motor functions,

regardless of the platform on which you plan to use the product. Always
keep these functions separate from each other.

7. USE WITH THE MICRO:BIT

7.1. Connection
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https://github.com/joy-it/SBC-MotoDriver3-Arduino
https://github.com/joy-it
https://github.com/joy-it/SBC-MotoDriver3-Arduino/blob/main/LICENSE
https://joy-it.net/files/files/Produkte/SBC-MotoDriver3/SBC-MotoDriver3-Testcode-ARD.zip

micro:bit SBC-MotoDriver3 External

SDA (Pin 20) SDA -
SCL (Pin 19) SCL -
- nFaultl -
- nFault2 -
Pin 8 OE -
3V VDD -
GND GND -
- nSLEEP1 =
- nSLEEP2 -

- VM/DC in External voltage source is

to be aligned according to
the specifications of the
motors

Please note that if you connect VDD to your micro:bit, you have to set
the output voltage of the voltage converter on the board to 3.3V with

the jumper to be able to supply your micro:bit with voltage via the
motor driver board.

You may need to use a breakout board to connect cables to some pins of

your Micro:Bit. In this example a breakout board is used. We recommend
the breakout board for micro:bit from Joy-IT.

7.2. Installation

For control we recommend the use of the pxt-SBC-MotoDriver3 library,
which has been published by Joy-IT under the GNU-Lizenz.

You can add the library by clicking on Extensions on the Makecode page

% Microsoft | @micro:bit & Blocks
Search
822 Basic
© Input
¢» Music

© Led

il Radio
C Loops
43 Logic

= Variables

B Math

( 111 Show data Device ) I v Advanced

SN - Do

and then typing https://github.com/joy-it/pxt-SBC_MotoDriver3 in the
search bar. After you have done that, all you have to do is click on the
extension to add it automatically for your current project.


https://github.com/joy-it/pxt-SBC_MotoDriver3
https://github.com/joy-it
https://github.com/joy-it/pxt-SBC_MotoDriver3/blob/main/LICENSE
https://makecode.microbit.org/#editor
https://joy-it.net/de/products/MB-CONN02

7.3. Code example
To test your Motor driver board, you can download a code sample from
us here or simply rebuild the code yourself as shown below.

If you have decided to download our code sample, then after unzipping
the file you can simply drag and drop the contents onto the Makecode
web page and release to import the file and open it automatically.

Micro:bit code example Figure:

B forever

serial write line Normal usage

on start

B r1nitialize the SBC_MotoDriver3 with Address e

Set the enablepin to Pin 8 ¥ and On ¥ B Turn on all Forward ¥ channels

B Turn off all channels LEVCM( N 1000 @

Turn off all channels

B Turn on all Backward ¥ channels

'pause (ms)
vTurn off all channels
vpause (ms)

VE Turn on channel o
vpause (ms)

LEVEC ()N 500 v

B Fade in channel ° over @Il milliseconds to @
Fade out channel o over @Il milliseconds to o
LEVM (N 1000

= serial write line Read the status of channel 0

serial write line Read the pwm status of channel o

pause (ms) @I-ZIAd4

Turn off all channels

7.4 Use of stepper motors

Please note that only one stepper motor can be connected per side. In
terms of hardware, it is important to use the appropriate stepper motors
for the permissible voltage range. In addition, regardless of the platform
on which you intend to use the product, make sure that you never
connect a stepper motor and a DC motor to the same side at the same
time. This can cause problems or even damage to the product.

In terms of software, make sure that you do not send the stepper motor
function to the same motor driver with the DC motor functions,
regardless of the platform on which you plan to use the product. Always
keep these functions separate from each other.



https://joy-it.net/files/files/Produkte/SBC-MotoDriver3/SBC-MotoDriver3-Testcode-MB.zip

7.5. Pairing the Micro:Bit

Click on the button located to the right of Upload/Download.

= Microsoft | O micro:bit ik Blocks JavaScript v a“ < 9 * Sign In @

Search Q
822 Basic
© Input

¢» Music
© Led
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C Loops

Logic

8

Variables

& om

Math

Exte]

=l - Do

Click Connect Device.

BB Microsoft | @ micro:bit k& Blocks JavaScript signin @

Search.

222 Basic
© Input
¢» Music
© Led
il Radio
C' Loops

4 Logic

= Variables

B Download as File

© Help

oot . [ECR -

Click Next.

EE \jicrosoft | O micro:bit Kk Blocks avaScript Sign In @

Download oo PCA9634 B




Click on Pair.

BB Microsoft | @ micro:bit Kk Blocks

< o o [N)

Search... Q
222 Basic |

2. Pair your micro:bit to your browser 0

Press the Pair button below.
makecods.microbit org wants to connect

85 miambi Mg 020
A window will appear in the top of your

browser.

Select the micro:bit device and click s

Connect.
Iv Advanced
SN - Do

Select your Micro:Bit in the opened window and click Connect to be able
to connect and use it.

makecode.microbit.org mochte eine Verbindung herstellen.

BBC micro:bit CMSIS-DAP

Abuvechen

The last thing you need to do is click on Done to be able to upload your
code. You upload your code by clicking Download.

B8 Microsoft | & micro:bit & Blocks S
Search... Q
N.. . . l

@ Connected to micro:bit

Sign In @

Your micro:bit is connected! Pressing
‘Download’ will now automatically copy your
code to your micro:bit.

© Download - PCA9634




8. ADDITIONAL INFORMATION

Our information and take-back obligations according to
the Electrical and Electronic Equipment Act (ElektroG)

Symbol on electrical and electronic equipment: E
R

This crossed-out dustbin means that electrical and electronic appliances
do not belong in the household waste. You must return the old appliances
to a collection point.

Before handing over waste batteries and accumulators that are not
enclosed by waste equipment must be separated from it.

Return options:

As an end user, you can return your old device (which essentially fulfills
the same function as the new device purchased from us) free of charge for
disposal when you purchase a new device.

Small appliances with no external dimensions greater than 25 cm can be
disposed of in normal household quantities independently of the
purchase of a new appliance.

Possibility of return at our company location during opening hours:

SIMAC Electronics GmbH, Pascalstr. 8, D-47506 Neukirchen-Vluyn,
Germany

Possibility of return in your area:

We will send you a parcel stamp with which you can return the device to
us free of charge. Please contact us by email at Service@joy-it.net or by
telephone.

Information on packaging:

If you do not have suitable packaﬁing material or do not wish to use your
own, please contact us and we will send you suitable packaging.

9. SUPPORT

If there are still any issues pending or problems arising after your purcha-
se, we will support you by e-mail, telephone and with our ticket support
system.

Email: service@joy-it.net

Ticket system: http://support.joy-it.net

Telephone: +49 (0)28459360-50 (Mon. - Thu.: 10:00 - 17:00 o'clock,
Fri.: 10:00 - 14:30 Uhr)

For further information please visit our website:
www.joy-it.net

Published: 11.3.2023

www.joy-it.net
SIMAC Electronics GmbH

Pascalstr. 8, 47506 Neukirchen-Vluyn
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